
Data Analysis &  
Post-Processing Review

www.transonic.com



PV Analysis 

PV Workbook RPV-6-wb Rev A 2014

2

Analyzing PV Loop Data in LabChart ......................................................................................................3
Analyzing PV Loop Data in LabScribe2 ...................................................................................................9
Post-Calculating Admittance Volume in LabScribe2 ............................................................................. 17
Post-Calculating Admittance Volume in AdVol .....................................................................................21

Table of Contents

http://www.transonic.com


PV Analysis 

PV Workbook RPV-6-wb Rev A 2014

3

Analyzing PV Loop Data in LabChart

The following document outlines the essential and suggested steps for 
analyzing PV loop data in LabChart software when used in conjunction 
with the ADV500 PV System. Every experiment is different and may require 
different settings or the use of different software features. Please contact 
ADInstruments directly for additional information about all the available 
features or any software functionality issues

For the purpose of this exercise, a sample file recorded from a healthy mouse 
using the ADV500 PV system will be used. Only raw data was recorded at the 
time of the experiment, therefore, this example does not show hemodynamic 
measurements as calculated channels over time. Remember, that these 
channels can be created during analysis if required to show trends over the 
course of the experiment.

GettinG StArted
Open up LabChart Software. Upon start-up a dialog box will appear and 
run through a diagnostic to confirm connection to PowerLab hardware. 
Connection to the PowerLab is not essential for data analysis: therefore, if no 
hardware is connected simply click OK to proceed.

The Welcome Centre will appear. Select the data file of interest from the “Recent 
Files” column, or click the OPEN icon to search for the file of interest. 

After selecting the file it will open in the LabChart Main Window.

Main window showing mouse left ventricle PV loop data. PV Loop menu is circled and the 
expanded view shown. PV Loop hotkeys are circled and the expanded view is shown above.

Close up view of PV Loop Hotkey menu

Technical Note: RPV-18-tn
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PV Loop Menu & Functions
This menu and its sub-menus include all setting, preferences, or functions that one will need to address in 
order to ensure correct PV data calculation.

WorkFLoW
Click to activate the Workflow function. Workflow will appear at the left hand side of the screen. This is 
not required for analysis of admittance data as True-Volume information is already available. However, if 
traditional volume calibration info needs to be addressed (i.e. Compute parallel volume (Vp) from a saline 
bolus infusion data set), Workflow will provide assistance with these steps. Consult the ADI LabChart User 
Manual for specific details on Workflow.

SettinGS
Open from the menu or hot-key to access 
the PV Loop Settings Dialog box. Ensure 
the following are correctly selected before 
moving forward with analysis:

1. Pressure Signal: select the appropriate 
Pressure Channel

2. Volume Signal: select the appropriate 
Volume Channel

3. Analysis Region: by selecting “Whole 
Channel” all registered PV cycles 
will be automatically included in the 
hemodynamic table. Typically this is 
not preferred, as families of specific 
loops will want to be studied. By 
choosing “Selection”, you will be able to 
highlight areas of interest in the Main 
Window which will then populate in the 
hemodynamic table.

4. Preview of Detected Loops: this section allows the researcher to confirm that each heart beat is being 
registered correctly as a cycle. Green Dot markers denote End Diastole, while Yellow Dot markers denote 
End Systole.

5. Loop Detection: this section allows the user to define how cycles will be registered by the software. The 
default setting is “Find from pressure signal” and is the best choice.

6. Minimum Peak and Minimum Period: These two settings allow the researcher to adjust the threshold by 
which the software registers a cardiac cycle.

SHoW CyCLe MArkerS
By selecting this option, cycle markers (Green and Yellow tags marking end diastole and end systole, 
respectively) will appear in the Main Window view. This will help to confirm that the software has correctly 
registered each cardiac cycle for analysis.

Analyzing PV Loop Data in LabChart Cont.

PV Loop Settings dialog Box

Technical Note: RPV-18-tn
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LooP VieW
Clicking this option in the menu or the hot-key 
will open up the Loop View Window. This XY-
Plot will contain the data selected from the Main 
Window (or entire data set if “Whole Channel” is 
selected in the Settings menu). Loop View displays 
the detected pressure volume loops as an XY line 
graph of pressure against volume. The End Systolic 
Pressure Volume Relationship (ESPVR) and the End 
Diastolic Pressure Volume Relationship (EDPVR) 
regression information are also displayed.

1. Instantaneous Readouts: To display readouts of 
instantaneous pressure and volume, move the 
tracking cursor over the end diastolic (ED) and 
end systolic (ES) points.

2. Loop Selection: You can highlight a particular 
loop in the display area, and select the loops 
that you would like included in the analysis.

a. To identify a specific loop, click on the 
ES or ED point, or click on the loop 
number on the left hand side of the 
view. This highlights the loop in blue. 
The corresponding row of calculated 
parameters in the Hemodynamics Table is 
also highlighted.

b. Only loops with a check in the box next to their loop number are included in the analysis. By default all 
loops are included. To exclude a loop from the analysis, deselect it by clicking on the check mark in the 
corresponding box. Deselecting a loop removes it from all views and calculations

3. Regression Information: The ESPVR and EDPVR best fit regression can be drawn on the graph and the 
regression information displayed at the top of the plot. To display this information check the boxes to the 
left of the ESPVR and/or EDPVR labels above the plot. For ESPVR, a linear or quadratic curve fit can be 
calculated and for EDPVR, a linear or exponential curve fit can be calculated (NOTE: Linear option is only 
there to force a calculation in the event of negative EDP values).

HeModynAMiCS tABLe
Clicking this option in the menu or hot-key will open the Hemodynamics Table Window. Beat-by-beat 
information will be displayed in a tab-delimited format for all selected loops. 

NOTE: In “Analyze While Sampling” mode, the contents of the parameters table are updated upon detection 
of each loop during data acquisition. Use the Scroll/Review button to toggle between automatic scrolling 
of newly added rows and reviewing of previously added rows. This feature can be used when data is being 
recorded at the bench top, but does not apply to pre-recorded data.

Analyzing PV Loop Data in LabChart Cont.

Loop View showing pressure and volume in an Xy plot. ed and eS points are 
shown. eSPVr and edPVr lines are shown. included loops are listed on the left.

Technical Note: RPV-18-tn
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Analyzing PV Loop Data in LabChart Cont.

When analyzing pre-recorded data the table’s contents are updated to show the data for the current Selection 
or for Whole Channel recorded data.

1. Loop Selection: Clicking on a row 
highlights that row of data and also 
highlights the related loop in Loop 
View. To select which loops are included/
excluded in your analysis, use the Loop 
View.

2. Column Format: Double clicking on 
the column heading opens the Column 
Format dialog. In this dialog you can 
select the number of significant figures 
the parameters are displayed with and 
apply it to all the columns.

3. Options and Summary Information: The 
Hemodynamics Table can display:

a. Columns for any of the calculated 
parameters. To select the parameters 
to be displayed, open the 
Hemodynamics Options dialog by 
clicking Options at the bottom of the 
Hemodynamics Table.

b. Summary rows at the bottom of the table show the average, minimum and maximum values, and the 
number of values, for each column. To turn on summary rows, click Options and select “Show summary 
pane” in the Hemodynamics Options dialog.

Hemodynamics table options dialog box for selecting which parameters are displayed.

Hemodynamics table window displays individual loop data and summary values from all selected loops.

Technical Note: RPV-18-tn

http://www.transonic.com


PV Analysis 

PV Workbook RPV-6-wb Rev A 2014

7

Analyzing PV Loop Data in LabChart Cont.

4. Exporting Data: There are two methods for exporting the 
contents of the Hemodynamics Table:

a. Click Export, then select either tab-delimited text file (.txt) 
or comma-delimited text file (.csv) and click Save. The 
output file can be imported into spreadsheet programs.

b. In the hemodynamics table, select the data of interest by 
holding down the left mouse button and dragging the 
cursor. Once the data is selected (highlighted in blue), press 
CTRL-C on the keyboard. Data will be transferred to the 
Clipboard. Open up an appropriate spreadsheet program, 
select the cell where you wish to import the first data point 
and press CTRL-V on the keyboard. NOTE: individual loop 
data and Summary data (AVG, MIN, MAX, COUNT), must be 
copied separately.

PV LooP PLotS
The next section of the menu lists the four available load-
independent PV loop plots:

1. PRSW: Preload recruitable stroke work (PRSW) is determined 
by the linear regression of stroke work with the end diastolic 
volume. The slope of the PRSW relationship is a highly linear 
index of myocardial contractility that is insensitive to preload 
and afterload. During heart failure, myocardial contractility is 
reduced which decreases the slope of the PRSW relationship. 
Recent studies also indicate that the volume axis intercept of 
the PRSW relationship (not the slope) may be a better indicator 
of the severity of contractile dysfunction.

2. dP/dt Max vs. EDV: a linear regression of the maximum 
derivative of pressure to end diastolic volume. The slope 
generated is also used to address changes in contractility. In 
general, a steeper slope suggest a more responsive change in 
contractility, while a shallow slope suggests a poor response to 
load change.

3. PVA vs. EDV: The Pressure-volume area (PVA) represents the 
total mechanical energy generated by ventricular contraction. 
This is equal to the sum of the stroke work (SW), encompassed 
within the PV loop, and the elastic potential energy (PE) (PVA 
= PE + SW). Pressure-Volume Area vs. End diastolic volume 
therefore represents a linear regression of mechanical energy 
to volume during load change: a steeper slope suggests a more 
responsive, healthier heart, while a shallow slope suggests 
contractile dysfunction.

PrSW: Stroke Work vs end diastolic Volume

Maximum dP/dt vs end diastolic Volume

Pressure Volme Area vs end diastolic Volume

Technical Note: RPV-18-tn
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Analyzing PV Loop Data in LabChart Cont.

4. PVA vs. ESP: Pressure-Volume Area vs. End systolic Pressure 
represents a linear regression of mechanical energy to peak 
pressure during load change: a steeper slope suggest a more 
responsive healthier heart, while a shallow slope suggests 
contractile dysfunction.

AnALySiS FunCtionS
Reselect Analyzed Data, Clear Analysis, and Analyze Selection 
are used to register, clear, or reselect (if changes are made but 
you wish to revert to the original sample of data points) data  
of interest.

Highlight data to be analyzed and select the appropriate 
analysis option. Choose from Baseline or Occlusion analysis 
based on the type of data.

Pressure Volume Area vs end Systolic Pressure

Technical Note: RPV-18-tn
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Analyzing PV Loop Data in LabScribe2

The following document outlines suggested steps for analyzing PV loop data in LabScribe2 software when 
used in conjunction with the ADV500 PV system. Every experiment is different and may require different 
settings or the use of different software features. Please contact iWorx directly for additional information 
about all the available features or any software functionality issues.

For the purpose of this exercise, a sample file recorded from a healthy pig using the ADV500 PV system will 
be used. Only raw data was recorded at the time of the experiment, therefore, this example does not show 
hemodynamic measurements as calculated channels over time. Remember, that these channels can be created 
during analysis if required to show trends over the course of the experiment.

Basic Labscribe2 Functions for PV Loops

Full screen view of the pig Left Ventricle PV data collected using the AdV500 PV System. 
there are three channels of raw data: Pressure (mmHg), Phase (degree°) and Magnitude 
(µS or mS) and one calculated channel: Volume (ml). the Xy view of Pressure-Volume 
Loops are on the right.

Technical Note: RPV-16-tn
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the Main Window toolbar features icons for quick access to key features that help with data manipulation and analysis.

each channel has its own control located in the channel bar immediately above channel’s data. the channel bar allows for zooming in and out, 
autoscaling the amplitude of recorded data, adding function to the channel, changing its title, etc.

the channel menu triangle 
contains functions specific to 
channel. the channel menu 
can also be accessed by 
right-clicking anywhere in the 
channel.

CHAnneL Menu
Important channel functions for data analysis include: 

• Invert: Inverts the trace

• Title: Opens a dialog allowing a change to the title of the channel 

• Color: Opens color palette allowing a change to the color of the channel trace

• Units: Displays unit conversion option

• Scale: Displays the option to control the vertical axis of the channel

Analyzing PV Loop Data in LabScribe2 Cont.

Technical Note: RPV-16-tn
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Analyzing PV Loop Data in LabScribe2 Cont.

uSinG & MoVinG CurSorS

The value of the single cursor or the difference between the two cursors is displayed in the Clock Area.

During data analysis, cursors can be moved by placing the mouse over the cursor clicking and dragging it to the 
right or left. The cursor on the left is always cursor number 1, while the cursor on the right is number 2. If you 
move cursor number 2 to the left past cursor 1 it becomes the new cursor number 1. 

In the two cursor mode, the cursors can be locked at a set interval to allow for viewing a constant amount of 
data. To lock separation distance, position the two cursors at the desired separation and choose “Tools > Lock 
Cursor Separation” To unlock the distance click “Lock Cursor Separation” a second time.

MArkinG A CHAnneL
Click on Single Cursor Icon in the Toolbar. Position the cursor on the file where the mark should be positioned. 
Then type text associated with this mark into the Marks area and hit enter. To later edit or delete the mark, 
access the mark dialog from View menu or by clicking on the Marks Icon on the Toolbar. Marks are valuable for 
keeping track of key events but can also be used to make note of system variables or experimental conditions.

In addition to marking static data, you can also make Marks during live data collection. To accomplish this, 
simply type your intended information in the Mark area (as described above) and hit Enter. A mark will be 
time-stamped at the moment that you hit Enter, allowing for easy data review following protocol completion.

Addition of Computed Function Channel
The addition of computed functional channels can aid in analysis by providing important 
information e.g. adding the Derivative from the raw Pressure channel (dP/dt channel). 
Other useful computed functional channels include Integral, Channel Math, Filter and 
Smoothing. To add a functional channel to the current channel click on [add function].

deriVAtiVeS
The Derivative function calculates the derivative (slope) around each point in the raw 
data, and then displays it on the calculated channel. On the new derivative channel, the 
units are changed to the units of the raw data channel/second. Higher order derivatives 
can be calculated by applying a Derivative function to a Derivative channel.

inteGrALS
An integral is the area under a curve. In pressure-volume data analysis you mostly 
utilize the integral calculating channel for performing pressure wave 
analysis or calculating the integral of a flow waveform from a Transonic 
Flowprobe to obtain stroke volume (SV). There are four types of 
integrals; the two most common ones are Standard and Absolute.

Standard: Includes all data points in the calculation.

Absolute: The Absolute Value of the Integral, as the name implies, 
makes all values of the integral positive and plots the running total. 
Data points with values above zero make the integral larger, those with 
values less than zero make the integral smaller. To successfully calculate 
the integral, the location of the zero-line or baseline needs to be 
established. 

Add function menu

Setting the baseline for use with integral

Technical Note: RPV-16-tn
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Analyzing PV Loop Data in LabScribe2 Cont.

Setting the baseline of the raw data channel to zero is important because this function defines the difference 
between positive and negative areas of the recording. If the baseline of the raw data record is in the positive 
range of amplitudes, then the integral will have a positive slope, even though no signal is present. Conversely, 
if the baseline of the raw data is in the negative range, the integral will have a negative slope.

CHAnneL MAtH
The Channel Math function applies a user-defined function to 
up to four data channels and displays the output in a computed 
channel. Each of four variables (A, B, C and D) can be associated 
with a user-selected data channel.

FiLterinG
A digital filter can be applied to any channel in real time or to 
previously recorded data. LabScribe2 uses a FIR (Finite Impulse Response) filter. There are various windowing 
functions that can be used for setting up an FIR filter. The Hamming window (default) is appropriate for most 
applications. In addition to the Hamming function, LabScribe2 also provides Rectangular, Bartlett, Hanning, 
Blackman and Blackman-Harris windowing functions.

For the data analysis of pressure-volume data, use a Smoothing function rather than data filtering to prevent 
loss of the pressure high-fidelity signal. It has been established by researchers that in order to accurately 
recreate a blood pressure waveform, the sensing system must be able to accurately measure up to the 
20th harmonic of the observed waveform (1). Furthermore, Dr. Grossman reports in his work the accuracy 
of capturing and reporting the pressure signal: “If components of a particular frequency range are either 
suppressed or exaggerated by the transducer system, the resulting signals will be greatly distorted (2).”

If you choose to filter your data, on the 
channel of interest, click on [add function] 
then select “Periodic > Frequency”. A 
Frequency channel in Hz will be created. 
Determine the highest frequency and then 
multiply by 20 to get the 20th harmonic. 
That value will become the “High Cutoff” 
value for the FIR filter. To apply the filter 
click on [add function] select “Filter > FIR 
Filter”.

SMootHinG
Smoothing is used to remove noise that is 
uniform across all frequencies. LabScribe2 
has the ability to smooth the data in 
order to reveal significant features of your 
data. There are two different algorithms 
to smooth the data; the Moving Average 
function does wide smoothing, while the 
Savitzky-Golay seeks to preserve shapes of 
peaks. 

The first channel is raw pressure data. The second channel is unmodified volume data. 
the third channel is volume data smoothed by Savitsky-Golay second order polynomial 
with 7 points of data on each side. the fourth channel is volume data smoothed by 
Savitsky-Golay second order polynomial with 21 points of data on each side. the red 
PV loops are created from the un-smoothed data while the green loops are from the 21 
points smoothed data.

Channel Math allows for custom functions based on up to 
four channels

Technical Note: RPV-16-tn
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Analyzing PV Loop Data in LabScribe2 Cont.

SMootHinG Cont.
The Savitzky-Golay method essentially performs 
a local polynomial regression to determine the 
smoothed value for each data point. For analysis of 
pressure-volume this method is superior to Moving 
Average because it tends to preserve features of the 
data such as peak height and width, which are often 
diminished by adjacent averaging.

When using the Savitsky-Golay smoothing function, 
it is best to start with a smaller number of points on 
each side and then increase the number of points later 
after assessing how the smoothing impacts the data to 
prevent data distortion from over smoothing.

Specific PV Loop Functions
Analysis specific to PV loops is started by choosing the 
“Advanced > PV Loops”, then choosing one of two options: 
Online Calculations and Offline Calculations. 

onLine CALCuLAtionS
Choose Online Calculations from the PV Loops submenu. Click on 
the triangle in the upper left corner to open the PV Loop Online 
Calculations Setup window. Select the appropriate Pressure 
Channel and Volume Channel for the loops. Set Average Cycles 
to something other than zero, otherwise the loop will never 
refresh. Set the threshold for detecting cycles to “Use percentage 
of Max and Min scaling” and adjust the threshold bars to include 
acceptable pressures. Keep in mind the impact of IVC occlusion 
(reduced pressure) when setting the threshold to ensure all cycles 
are included.

oFFLine CALCuLAtionS
Choose Offline Calculations from the PV Loops submenu to open 
the PV Loop Calculations Dialog. The panels of this dialog can be 
re-sized by moving the mouse cursor over the boundaries until a 
double headed arrow appears, and dragging the boundaries to 
re-size the panels.

LabScribe2 can calculate virtually every PV Loop derived parameter 
(Steady-state or post-occlusion condition) of cardiac function. XY 
graphs display relationships among the parameters. All calculations 
can be exported or copied to MS Excel or other spreadsheets for 
further analysis. The graphs can all be copied as images to include 
in presentations or manuscripts. When the Offline calculations is 
open, 4 tab panels become available: Channels, Setting, Results 
and Display.

Select PV Loop Online or Offline Calculations

PV Loop online Calculations Setup Menu

open the PV Loop online Calculations Setup Menu by clicking the 
triangle in the corner.

Technical Note: RPV-16-tn
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Analyzing PV Loop Data in LabScribe2 Cont.

CHAnneLS
The Channels tab enables the selection 
of the channels that will be displayed in 
the XY graph. To create PV loops select 
the Pressure channel and Volume channel 
along with the appropriate units. Once 
the Pressure and Volume channels are 
designated, the PV Loops will be displayed 
in the XY graph area for all the cycles in 
the selection. Define the region of interest 
by adjusting the two cursors in the 
channel display area at the top of the PV 
Loops Calculations Dialog. This will select 
the amount of PV loops (in this case 12). 

If you wish to add more PV loop cycles 
than the amount available in the top 
channel, you have to go back to the Main 
Window and use the double display time 
icon to increase the amount of PV loop 
data. 

The highlighted cycle in the Cycles Selected window 
is shown in red, while all other selected cycles are 
displayed in green. Parameters related to each cycle 
are shown in the table at the bottom. Cycles can 
be deselected (or selected) by clicking on the check 
box to the left of the cycle number. This allows for 
identifying individual loops (individual cycles) for 
inclusion or exclusion from the analysis.

SettinGS
• When recording using ECG channel, check whether 

you wish to use an ECG for the detection of end 
diastole (ED). 

• For OCCLUSION condition, please choose whether 
a linear or an exponential fit should be applied 
to the End-Systolic Pressure-Volume Relationship 
(ESPVR) data, using the ESPVR Fit Type drop-down 
box. In rodents, linear is generally used; in larger 
animals, compare both linear and exponential fit. 
Please review appropriate literature in order to 
select ESPVR fit type. 

• For OCCLUSION condition, leave EDPVR fit type as 
exponential. This relationship is based on literature 
citation (3). If pressures fall below zero, a message 
will appear requesting that the data be offset 
in the positive direction in order to perform the 
calculation.

Channels tab for selecting the data channels used to create the PV loops. use the Cycles 
Selected menu to include or exclude specific loops.

Settings tab for selecting the methods for calculating key parameters

Technical Note: RPV-16-tn
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Analyzing PV Loop Data in LabScribe2 Cont.

• Choose the value in each cycle that should 
be used to compute end-systole (ES), and 
how far to offset ES from the specified 
value. 

• For OCCLUSION condition, by default, the 
maximum Pressure to Volume ratio is used 
to identify ES. When calculating PRSW 
(Preload Recruitable Stroke Work), it is 
calculated by using detection of EDV rather 
than V max. If the isovolumic contraction 
period of the PV loop is deformed or, 
in case of RV-PV loops, select Vmax to 
reanalyze. 

• Enter the stop value to be included in the 
best fit line used for the determination 
of isovolumic relaxation time (IVRT) Tau. 
Tau is the isovolumic time constant and 
is calculated using the line from dPmin to 
this user-defined point. Leave the value 
of 5 mmHg as a user defined point for the 
beginning of analysis. For more info about 
Tau please see ”Understanding Lusitropy.”

• For Cycle detection threshold sensitivity and 
Ventricular Wall Volume, leave the number 
of cycles that should be used to determine 
the Cycle Detection Threshold Sensitivity 
with default values.

• In case you wish to use PV loop(s) 
superimposed on each other for comparison 
,please select Save Occlusion data tab. 
Select File name and iWorx Occlusion 
file (.iwxocc) format. This superimposed 
data can also be used to compare PV 
loops during Steady state conditions or to 
compare multiple vs single loops.

reSuLtS
The equations defining ESPVR, EDPVR, PRSW, Max dP vs. EDV, PVA vs. EDV, and PVA vs. ESP are displayed, as 
is Emax. By clicking on the Algorithm button, parameters are detailed including the description/or literature 
citation. Parameters that are displayed can be easily copied using the copy button. When you select copy, 
parameters are copied for both occlusion and steady state, although only occlusion values are displayed. When 
copied into MS Excel or another program, they can be easily post-processed.

Click [table options] to adjust which parameters are displayed

results tab to view the equations used for calculating key parameters

Technical Note: RPV-16-tn
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Analyzing PV Loop Data in LabScribe2 Cont.

diSPLAy
Clicking on a graph color allows for selection of a basic color 
or for creating a custom color for each type of selection. 
When it is necessary to hide a selection, as in the case of PVR 
lines for description of steady state PV loops, the color can 
be set to white.

Other display parameters that will be shown on PV loop 
graph include ES location, ED location, ESPVR, EDPVR, Ees 
vs. Ea, Tau start, Tau stop, and Average loop. When selected, 
parameters will appear on the PV loop graph.

reFerenCeS
(1) Bernard J Gersh, Clive e.W. Hahn and Cedric Prys-roberts: “Physical Criteria for Measurement of Left Ventricular Pressure and its First derivative.” 
Cardiovascular research, 1971, 5, 32-40

(2) dr. William Grossman, Grossman’s Cardiac Catheterization, Angiography, & intervention, 7th edition: 2006 Lippincott Williams & Wilkins. pg 134

(3) Burkhoff d, Mirsky i, Suga H. “Assessment of systolic and diastolic ventricular properties via pressure-volume analysis: a guide for clinical, 
translational, and basic researchers.“ Am J Physiol Heart Circ Physiol. 2005 Aug;289(2):H501-12

display tab for selecting the parameters visible on the graph and 
their colors.

Technical Note: RPV-16-tn

http://www.transonic.com


PV Analysis 

PV Workbook RPV-6-wb Rev A 2014

17

Post-Calculating Admittance Volume in LabScribe2

VAriABLeS
ρ = blood resistivity

L = measuring electrode distance

Gb = measured Blood conductance (separated 
     from parallel/muscle conductance using 
     admittance phase measurement)

Transonic Scisense Technical Note    A. Henton and F. Konecny 
                                                March, 2013 

Wei’s SV Correction: 

To demonstrate the calculations for Wei’s SV correction factor, we will use two sample points in the 
cardiac cycle (End-Systole and End-Diastole as determined by dP/dt inflection points).  This is required as 
Wei’s SV correction is dynamic and therefore unique to any stage of the cardiac cycle.  The same 
variables used above in Baan’s SV correction will apply: 

L = 4.5 mm  

ρ = 1.2 Ohm·m  

SVreference = 32uL (as derived from hi-resolution echocardiography) 

Gb-ED = 855 uS = 0.855 mS 

Gb-ES = 465 uS = 0.465 mS 
 

�1 − 𝐺𝐺𝑏𝑏
𝛾𝛾
� ,𝑤𝑤ℎ𝑒𝑒𝑒𝑒𝑒𝑒   γ = 

−𝑏𝑏 ±√𝑏𝑏2−4𝑎𝑎𝑎𝑎
2𝑎𝑎

  
 

𝑎𝑎 = 𝑆𝑆𝑆𝑆 − 𝜌𝜌𝐿𝐿2(𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 − 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸)  32 − (1.2)(4.5)2(0.855 − 0.465) = 22.5230 

𝑏𝑏 = −𝑆𝑆𝑆𝑆 · (𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 + 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸) −32(0.855 + 0.465) = - 42.2400 
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−𝑏𝑏 ±√𝑏𝑏2−4𝑎𝑎𝑎𝑎
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  42.24 ±�−42.242−4(22.5230 ∙ 12.7224)

2(22.5230)
= 1.4984 and 0.3770  

Note:  Wei’s equation always uses the larger postive solution for γ (1.4984) 
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A mathematical review of SV correction factors employed in Baan’s 
equation and Wei’s equation: 

 

Baan’s equation: 

 

𝑉𝑉𝑉𝑉𝑉𝑉 = 1
𝛼𝛼
𝜌𝜌𝜌𝜌2(𝐺𝐺𝑥𝑥 −G.𝑝𝑝) 

 

 

Note:  for the purpose of this document we will not use a hypertonic saline bolus process to calculate 
the average Vp to satisfy Baan’s equation.  Instead we will employ the admittance correction process 
reliant on phase shift measurement.  By doing this we can better compare resulting volume 
measurements derived by each Baan’s and Wei’s equations and understand the effect of each unique SV 
correction factor.  Therefore, after satisfying Vp by admittance we can understand Baan’s equation as: 

𝑉𝑉𝑉𝑉𝑉𝑉 =
1
𝛼𝛼
𝜌𝜌𝜌𝜌2(𝐺𝐺𝑏𝑏) 

 

Wei’s Equation: 

 

 

𝑉𝑉𝑉𝑉𝑉𝑉 = 1

(1−𝐺𝐺𝑏𝑏𝛾𝛾 )
𝜌𝜌𝜌𝜌2(𝐺𝐺𝑏𝑏)  

Where:  
ρ = blood resistivity 
L = measuring electrodes distance 

α = SV correction factor = 
𝑆𝑆𝑆𝑆𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐
𝑆𝑆𝑆𝑆𝑟𝑟𝑐𝑐𝑟𝑟𝑐𝑐𝑟𝑟𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐

 

Gx = measured TOTAL conductance 
Gp = parallel/muscle conductance  
(assumed to be removed by hypertonic saline injection) 

 

𝑏𝑏 = −𝑆𝑆𝑉𝑉 · (𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 + 𝐺𝐺𝑏𝑏−𝐸𝐸𝑆𝑆) 

𝑐𝑐 = 𝑆𝑆𝑉𝑉 · 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 · 𝐺𝐺𝑏𝑏−𝐸𝐸𝑆𝑆  

Where:  
ρ = blood resistivity 
L = measuring electrodes distance 
Gb = measured BLOOD conductance  
(calculated using admittance process, involving removal of 
parallel/muscle conductance using phase measurement) 

γ = 
−𝑏𝑏 ±√𝑏𝑏2−4𝑎𝑎𝑎𝑎

2𝑎𝑎
  

where, 

 𝑎𝑎 = 𝑆𝑆𝑉𝑉 − 𝜌𝜌𝜌𝜌2(𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 − 𝐺𝐺𝑏𝑏−𝐸𝐸𝑆𝑆) 

Wei’s equationThe Scisense ADV500 system offers a method for 
deriving ventricular volume called admittance. While 
the ADV500 system derives true ventricular volume 
in real-time, there are certain circumstances where 
the researcher may wish to manually calculate volume 
using the admittance method post-experiment. The 
benefit of doing this is that it offers the researcher 
full control of all of the variables that influence the 
resulting volume. Referring to Wei’s equation, these 
variables are: Stroke Volume (SV), Blood Resistivity 
(ρ), Heart Type (σ/ε), Measuring Electrode Distance (L), 
Blood Conductance at End-Systole (Gb-ES) and Blood 
Conductance at End-Diastole (Gb-ED).

The following outlines how to use LabScribe2 
software from iWorx to analyze the raw data traces of 
Magnitude, Phase, and Pressure to manually calculate 
volume using the admittance process and Wei’s 
equation. 

First select a stable baseline data set. 

On the Magnitude Channel select “Add Function > 
PVLoop > Blood Conductance”.

Technical Note: RPV-4-tn

Baseline PV data set
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Post-Calculating Admittance Volume in LabScribe2 Cont.

After selecting “Blood Conductance” a dialog box will appear 
(pictured right). Complete the “Settings” for Magnitude, Phase, 
Species and Sigma/Epsilon, also referred to as ‘Heart Type’ in current 
ADV500/ADVantage 5.0 systems. In this example, the standard for 
healthy tissue was used (S/E = 800,000 units). After selecting the “OK” 
button on the dialog box, a new channel for blood conductance will 
appear.

important: Catheter Calibration tab
This section allows the researcher to account for any internal 
capacitance inherent to the Catheter itself.

• For data sets collected with the ADVantage PV System (Version 3.0 
– 4.52), you can access this table of information on the ADVantage 
Control Unit by connecting the Catheter that was used to acquire 
the data and navigating to the “Catheter Information” option (see 
manual for specific menu location). Entering the specific values for 
that Catheter are ideal. However, if this information is inaccessible, 
resort to the defaults provided (example below on left). 

• For data sets collected with the ADVantage/ADV500 PV System 
(Version 5.0 or greater), the internal capacitance of the Catheter is 
automatically removed from the phase signal before it is output as 
an analog signal to your data acquisition system. Therefore, there is 
no additional correction for internal capacitance required. To negate 
this process in LabScribe2, enter a “0” in each cell in the Phase 
column (example below on right) 

Catheter Calibration for AdVantage Version 3.0-4.52 Catheter Calibration for AdVantage Version 5.0+

Technical Note: RPV-4-tn

Admittance Volume Calculation dialog box
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Post-Calculating Admittance Volume in LabScribe2 Cont.

On the Pressure Channel, select “Add 
Function > Derivative.” After selecting 
“Derivative” a new channel will appear 
for dP/dt. This channel will be used to 
accurately locate the end-diastolic and end-
systolic time points.

Change to Analysis View by selecting “View 
> Analysis” or by selecting the Analysis 
View icon. Use the vertical cursors to 
highlight maximum and minimum dP/dt 
points and corresponding measurements 
Gb-ED and Gb-ES, respectively. Make note of 
the measured Gb-ED and Gb-ES values and 
return to the Main Window view.

On the Magnitude Channel select “Add 
Function > PVLoop > Admittance Volume”. 

After selecting “Admittance Volume” a 
dialog box will appear (pictured right). 
Complete the Settings for Pressure, 
Magnitude, Phase, Species, “Sigma/
Epsilon” (also referred to as “Heart Type” 
in ADV500/ADVantage 5.0 system), Blood 
Resistivity, Gb-ED, Gb-ES, Segment Length 
(Measuring Electrode Distance), and 
Reference Stroke Volume. Address Catheter 
calibration tab as previously described 
above.

Technical Note: RPV-4-tn

dP/dt min and max points corresponding to Gb-ed and Gb-eS, respectively

Gb-ed and Gb-eS are input into admittance volume calculation
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Post-Calculating Admittance Volume in LabScribe2 Cont.

After selecting “OK” on the dialog box a new channel for Admittance Volume will be populated. Rename the 
channel as desired (ex. Volume New). To quantify the difference between the new volume derivation and the 
original recorded at the bench, use the “Offline PV Loop” analysis functions. You can superimpose the data 
sets and see if the alterations in coefficients for Wei’s equation (such as SV reference or blood resistivity) derive 
a significantly different volume. Outside of the coefficients, the post calculated volume theoretically yields 
the most accurate volume, as the measurement of Gb-ED and Gb-ES are specific to that moment of the data 
file (this is another valuable use of the post calculation process in the event an accurate baseline scan was not 
performed during live data collection).

Superimposed data sets (original Volume is Blue and new Volume is Green). note: no visible difference is observed in the volume measurements 
because the original volume was derived in real-time using the exact same volume coefficients for Wei’s equation and an accurate baseline scan 
was performed within this range of data.

Technical Note: RPV-4-tn
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Post-Calculating Admittance Volume in AdVol

VAriABLeS
ρ = blood resistivity

L = measuring electrode distance

Gb = measured Blood conductance (separated 
   from parallel/muscle conductance using 
   admittance phase measurement)
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Wei’s SV Correction: 

To demonstrate the calculations for Wei’s SV correction factor, we will use two sample points in the 
cardiac cycle (End-Systole and End-Diastole as determined by dP/dt inflection points).  This is required as 
Wei’s SV correction is dynamic and therefore unique to any stage of the cardiac cycle.  The same 
variables used above in Baan’s SV correction will apply: 

L = 4.5 mm  

ρ = 1.2 Ohm·m  

SVreference = 32uL (as derived from hi-resolution echocardiography) 

Gb-ED = 855 uS = 0.855 mS 

Gb-ES = 465 uS = 0.465 mS 
 

�1 − 𝐺𝐺𝑏𝑏
𝛾𝛾
� ,𝑤𝑤ℎ𝑒𝑒𝑒𝑒𝑒𝑒   γ = 

−𝑏𝑏 ±√𝑏𝑏2−4𝑎𝑎𝑎𝑎
2𝑎𝑎

  
 

𝑎𝑎 = 𝑆𝑆𝑆𝑆 − 𝜌𝜌𝐿𝐿2(𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 − 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸)  32 − (1.2)(4.5)2(0.855 − 0.465) = 22.5230 

𝑏𝑏 = −𝑆𝑆𝑆𝑆 · (𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 + 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸) −32(0.855 + 0.465) = - 42.2400 

𝑐𝑐 = 𝑆𝑆𝑆𝑆 · 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 · 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸   32(0.855 ∙ 0.465) = 12.7224 

 

γ = 
−𝑏𝑏 ±√𝑏𝑏2−4𝑎𝑎𝑎𝑎

2𝑎𝑎
  42.24 ±�−42.242−4(22.5230 ∙ 12.7224)

2(22.5230)
= 1.4984 and 0.3770  

Note:  Wei’s equation always uses the larger postive solution for γ (1.4984) 
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To demonstrate the calculations for Wei’s SV correction factor, we will use two sample points in the 
cardiac cycle (End-Systole and End-Diastole as determined by dP/dt inflection points).  This is required as 
Wei’s SV correction is dynamic and therefore unique to any stage of the cardiac cycle.  The same 
variables used above in Baan’s SV correction will apply: 

L = 4.5 mm  

ρ = 1.2 Ohm·m  

SVreference = 32uL (as derived from hi-resolution echocardiography) 

Gb-ED = 855 uS = 0.855 mS 

Gb-ES = 465 uS = 0.465 mS 
 

�1 − 𝐺𝐺𝑏𝑏
𝛾𝛾
� ,𝑤𝑤ℎ𝑒𝑒𝑒𝑒𝑒𝑒   γ = 

−𝑏𝑏 ±√𝑏𝑏2−4𝑎𝑎𝑎𝑎
2𝑎𝑎

  
 

𝑎𝑎 = 𝑆𝑆𝑆𝑆 − 𝜌𝜌𝐿𝐿2(𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 − 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸)  32 − (1.2)(4.5)2(0.855 − 0.465) = 22.5230 

𝑏𝑏 = −𝑆𝑆𝑆𝑆 · (𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 + 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸) −32(0.855 + 0.465) = - 42.2400 

𝑐𝑐 = 𝑆𝑆𝑆𝑆 · 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 · 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸   32(0.855 ∙ 0.465) = 12.7224 

 

γ = 
−𝑏𝑏 ±√𝑏𝑏2−4𝑎𝑎𝑎𝑎

2𝑎𝑎
  42.24 ±�−42.242−4(22.5230 ∙ 12.7224)

2(22.5230)
= 1.4984 and 0.3770  

Note:  Wei’s equation always uses the larger postive solution for γ (1.4984) 
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A mathematical review of SV correction factors employed in Baan’s 
equation and Wei’s equation: 

 

Baan’s equation: 

 

𝑉𝑉𝑉𝑉𝑉𝑉 = 1
𝛼𝛼
𝜌𝜌𝜌𝜌2(𝐺𝐺𝑥𝑥 −G.𝑝𝑝) 

 

 

Note:  for the purpose of this document we will not use a hypertonic saline bolus process to calculate 
the average Vp to satisfy Baan’s equation.  Instead we will employ the admittance correction process 
reliant on phase shift measurement.  By doing this we can better compare resulting volume 
measurements derived by each Baan’s and Wei’s equations and understand the effect of each unique SV 
correction factor.  Therefore, after satisfying Vp by admittance we can understand Baan’s equation as: 

𝑉𝑉𝑉𝑉𝑉𝑉 =
1
𝛼𝛼
𝜌𝜌𝜌𝜌2(𝐺𝐺𝑏𝑏) 

 

Wei’s Equation: 

 

 

𝑉𝑉𝑉𝑉𝑉𝑉 = 1

(1−𝐺𝐺𝑏𝑏𝛾𝛾 )
𝜌𝜌𝜌𝜌2(𝐺𝐺𝑏𝑏)  

Where:  
ρ = blood resistivity 
L = measuring electrodes distance 

α = SV correction factor = 
𝑆𝑆𝑆𝑆𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐
𝑆𝑆𝑆𝑆𝑟𝑟𝑐𝑐𝑟𝑟𝑐𝑐𝑟𝑟𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐

 

Gx = measured TOTAL conductance 
Gp = parallel/muscle conductance  
(assumed to be removed by hypertonic saline injection) 

 

𝑏𝑏 = −𝑆𝑆𝑉𝑉 · (𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 + 𝐺𝐺𝑏𝑏−𝐸𝐸𝑆𝑆) 

𝑐𝑐 = 𝑆𝑆𝑉𝑉 · 𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 · 𝐺𝐺𝑏𝑏−𝐸𝐸𝑆𝑆  

Where:  
ρ = blood resistivity 
L = measuring electrodes distance 
Gb = measured BLOOD conductance  
(calculated using admittance process, involving removal of 
parallel/muscle conductance using phase measurement) 

γ = 
−𝑏𝑏 ±√𝑏𝑏2−4𝑎𝑎𝑎𝑎

2𝑎𝑎
  

where, 

 𝑎𝑎 = 𝑆𝑆𝑉𝑉 − 𝜌𝜌𝜌𝜌2(𝐺𝐺𝑏𝑏−𝐸𝐸𝐸𝐸 − 𝐺𝐺𝑏𝑏−𝐸𝐸𝑆𝑆) 

The Scisense ADV500 system offers a method for deriving 
ventricular volume called admittance. While the ADV500 
system derives true ventricular volume in real-time, there 
are certain circumstances where the researcher may wish 
to manually calculate volume using the admittance method 
post-experiment. The benefit of doing this is that it offers 
the researcher full control of all of the variables that 
influence the resulting volume. Referring to Wei’s equation, 
these variables are: Stroke Volume (SV), Blood Resistivity (ρ), 
Heart Type (σ/ε), Measuring Electrode Distance (L), Blood 
Conductance at End-Systole (Gb-ES) and Blood Conductance 
at End-Diastole (Gb-ED).

The following outlines how to use AdVol software from 
Transonic to analyze the raw data traces of Magnitude, 
Phase, and Pressure to manually calculate volume using the 
admittance process and Wei’s equation. After generating the 
new volume, pressure and volume data can be saved in text 
format and imported into a PV analysis software.

Upon opening AdVol software you will be prompted to 
select which version of the ADVantage/ADV500 PV system 
was used to acquire the data file of interest.

By selecting “ADVantage 4.x”, the user will be presented 
with the option to input Catheter calibration values on the 
“Catheter Calibration” tab (see below). You can access this 
table of information on the ADVantage Control Unit by 
connecting the Catheter that was used to acquire the data 
and navigating to the “Catheter information” option (see 
manual for specific menu location). Entering the specific 
values for the catheter used are ideal. However, if this 
information is not available simply resort to the defaults 
provided. When selecting “ADVantage 5.x/ADV500”, the 
“Catheter Calibration” tab appears blank.

Wei’s equation

WHy iS tHe SySteM VerSion iMPortAnt?
Original versions of the ADVantage PV 
system (3.0-4.52) provide a phase output 
signal which includes the intrinsic capacitive 
contribution of the PV catheter itself, while 
newer versions of the ADVantage/ADV500 PV 
system (5.0 +) do not. Therefore, if the data 
set of interest was collected with an earlier 
version of the system it is appropriate to 
remove this ‘internal Catheter capacitance’ 
contribution from the phase signal before 
moving forward with the admittance 
volumetry process. 

Technical Note: RPV-5-tn

Catheter calibration for AdVantage 4.x systems
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Post-Calculating Admittance Volume in AdVol Cont.

After selecting the correct data version, the main window will populate. 
In the left margin, all features and controls are available for loading 
a sample file, addressing admittance volume variables, and applying 
standards or saved settings.

• Define a calibration name in the event you wish to use the same 
settings for a series of data sets (ie. Control Mouse_Group 1).

• Select the appropriate Species from the Drop Down menu (Mouse, Rat, 
Rabbit, Large). Note: the term “Large” is appropriate for all animal 
data sets collected with 5F and 7F PV Catheters (ex. Dog, Pig, Sheep). 

• Select the correct ‘Heart Type’ for the data file of interest, or use 
‘Custom’ to define a specific Muscle Sigma/Epsilon value.

• REMINDER: Standard values are 800 K/s for healthy heart tissue, and 
900 K/s for hearts with any degree of infarct.

• Input values for Blood Resistivity; Segment Length, and Stroke Volume 
Reference value.

• Next, select the mode by which you wish to run the admittance 
volume calculation. “W” mode is the standard method which relies 
on the published and validated process including Wei’s equation. “D” 
mode is a simplified process that does not take into account the full 
Phase wave information. This should only be used as a last resort if the 
recorded phase information is corrupt or other circumstances affected 
proper recording of Phase. For more information, please refer to the 
ADVantage/ADV500 User Manual. 

• Finally, type in the ‘Sampling Frequency’ at which the original data 
was recorded. Typical rodent data files are recorded at 1000 Hz, while 
larger animal data files are recorded between 200 and 500 Hz. It is 
imperative that the exact sampling value used to record the original 
data is entered or the data file will not map properly when imported.

Once all settings are addressed, click “Input”. A dialogue box will appear 
allowing you to select a file of interest. The following file formats are 
acceptable: Text (.txt), Comma Separated (.csv), Tab Separated (.tab), 
Ponemah (.ascii). 

After selecting a file the data table columns for Pressure, Admittance/ 
Magnitude, and Phase will auto-populate. AdVol should recognize the 
data values that are correct for each column. However, if they load 
incorrectly the “Swap” buttons below the table can be used to shift the 
data values to the correct place.

Once the data is correctly mapped and all variables are confirmed, 
the wave forms should be interpreted in the main window in order to 
sample Gb-ED and Gb-ES values.

Technical Note: RPV-5-tn

Admittance volume variables are required for 
analysis
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Post-Calculating Admittance Volume in AdVol Cont.

In the main window area, right click on the lower graph to activate a “baseline scan:” 

The results of the scan will provide a measured 
value for Gb-ED, Gb-ES, and will show where on 
the wave trace these values were calculated. 
Remember: Gb-ED should always be larger than 
Gb-ES, and both values should be positive. If the 
scan results in negative numbers or the values 
are outside of physiological range repeat the 
scan and double check that the data is properly 
mapped.

After clicking “Yes”, the Gb-ED and Gb-ES 
values will auto-populate in the left margin. 
Waveforms for both Blood Conductance and 
Volume will appear in the main window, and a 
pressure vs. volume graph will be created.

Right Click Here

Technical Note: RPV-5-tn

use the automatic detection values of Gb-ed and Gb-eS

Perform a baseline scan by right clicking in the lower graph to automatically detect Gb-ed and Gb-eS values
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Check boxes are located in the bottom left corner of the main window allowing Conductance and/or Volume 
waveforms to be turned off. This assists in viewing one particular waveform at a time to aid in checking that 
the values are physiologically acceptable. 

At this stage admittance volume variables can be altered, if needed. Simply type the values into the 
appropriate cell in the left margin. To ensure the effects of altering a variable are carried through to the 
volume derivation completely, it is recommended that another scan is performed for Gb-ED and Gb-ES. 

Once a final volume suitable for export is rendered, click “File > Save Data” to export. The saved file will 
include only Pressure and Volume data and will have the same sample frequency as the import file (ie. 1000 
Hz). Data can be saved in the following formats: Text (.txt), Comma Separated (.csv), Tab Separated (.tab). 
These are common file formats that are accepted by most commercially available PV loop analysis software 
programs such as ADInstruments LabChart, EMKA IOX, Notocord Heme, and BioPac Acqknowledge.

Post-Calculating Admittance Volume in AdVol Cont.

Technical Note: RPV-5-tn

Final calculated PV loop based on admittance values in the left side bar
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transonic Systems inc. is a global manufacturer of innovative biomedical measurement 
equipment. Founded in 1983, transonic sells “gold standard” transit-time ultrasound 
flowmeters and monitors for surgical, hemodialysis, pediatric critical care, perfusion, 
interventional radiology and research applications. in addition, transonic provides 
pressure and pressure volume systems, laser Doppler flowmeters and telemetry systems.
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